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Introduction

BD Falcon™ FluoroBlok™ Inserts and BD BioCoat™ Multiwell Insert Cell-Based Assays
provide platforms for real-time analysis of samples using fluorescence-based detection.
These products are used for a variety of applications including analyses of cell motility
and compound permeability. To monitor the appearance of fluorescence in the chamber
located below the insert, a bottom-reading fluorescence plate reader is required.

This Technical Bulletin describes Set Up Guidelines for a variety of instruments that
are amenable to insert-based assays. To determine the optimal set up parameters,

BD Biosciences performed fluorescence-based assays using BD FluoroBlok inserts in
conjunction with a number of fluorescence plate readers including the Applied Biosystems
CytoFluor® 4000, Bio-Tek Synergy, BMG FLUOstar Galaxy and OPTIMA, PerkinElmer
Victor™, PerkinElmer HTS 7000, TECAN SpectraFluor Plus, and Thermo LabSystems
Fluoroskan Ascent.

Note: The information contained within this Technical Bulletin applies to all BD Falcon
FluoroBlok Insert Systems and BD BioCoat Multiwell Insert Cell-Based Assays (i.e.,
Tumor Invasion Systems, Angiogenesis Systems).

Insert System Assembly and Orientation

To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner. With the plate in this position, the BD Falcon logo will
be located on the right side.

Plate Reader Set Up

For use with BD FluoroBlok inserts, the fluorescence plate reader must support
bottom-reading epifluorescence detection mode (i.e., excitation light is presented to
the sample through the bottom of the base plate and emitted light is collected from the
bottom). If top- and bottom-reading are supported by the instrument in use, one can
switch between the two reading modes by software control or manual reconfiguration
of the hardware. Before proceeding, ensure that the bottom-reading mode is operative
and/or specified by the stored plate reading method (if applicable).

Notes:

o The placement of the insert wells in the 24-Multiwell format is not symmetrical
and requires a non-standard 24-well plate dimension.

e In some plate readers the individual 24-well or 24-Multiwell Insert plates must be
read without the lid.

e If additional information is needed regarding the reference points and plate reader set
up, please contact the instrument manufacturer technical support group.

® BD is not responsible for damaged property associated with defining new plate
maps or instrument modification.

BD Biosciences

Clontech

Discovery Labware
Immunocytometry Systems
Pharmingen

BD Biosciences Discovery Labware

www.bdbiosciences.com A‘"g" B D




Template Set Up

To add a new plate format template to the plate reader template menu, enter the
plate layout dimensions into the plate reader software formula. The required values
for some commonly used plate readers are listed in this Technical Bulletin. Detailed
drawings with exact well locations are available by contacting BD Biosciences
Discovery Labware Technical Service at 800.343.2035. Please consult the instrument
User Manual to obtain key reference points and units.

BD Biosciences strongly recommends you familiarize yourself with the plate reader
and have the templates loaded in your plate reader prior to starting your experiment.

Autofluorescence Background

If fluorescence is monitored with a top-reading instrument, the BD Falcon™
FluoroBlok™ PET membrane exhibits negligible autofluorescence across the visible
spectrum (490-700 nm). However, a low level of background fluorescence is detected
with a bottom-reading instrument due to autofluorescence and/or a reflection from the
polystyrene base plate. The use of very high gain settings ("lamp energy" or other
terms may be used) or the lack of appropriate assay controls may promote an auto-
fluorescence effect that is independent of insert-mediated autofluorescence. A gain
setting that is too high may also lead to saturation of the detector with samples that
exhibit very high fluorescence. The optimal gain or lamp intensity settings must

be determined empirically. As a starting point, initiate the experiment with a gain
setting of 50 or a lamp intensity setting at the midpoint.

Fluorescence Detection Issues

Note: Prior to reading BD Falcon FluoroBlok Inserts or BD BioCoat™ Multiwell
Insert Cell-Based Assays, ensure that the reader has the appropriate Excitation and
Emission Filter set installed.

Appropriate Excitation and Emission Filters for detection of fluorophore(s) used
in cell labeling must be employed, unless a monochromator-based plate reader
(e.g., TECAN SAFIRE) is available. To ensure that all samples are measured as
accurately as possible, an appropriate gain or lamp intensity setting must be used.



Applied Biosystems
CytoFluor® 4000

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate Excitation
and Emission Filter set installed, and the proper insert plate type is specified in the
Plate Type list.
Check Installed Filter Set
e Open the CytoFluor software program
® Open the Excitation and Emission Filter drop down menus and choose the
appropriate filter set

Note: If the appropriate filters are not installed, refer to the CytoFluor manual for
instructions.

Plate Dimensions

DO NOT READ INDIVIDUAL 24-WELL or 24-MULTIWELL FORMATS WITH THE
LID ON THE PLATE.

Note: The CytoFluor 4000 TC (Temperature Control) model cannot read the 24-well
or 24-Multiwell formats, as they are too tall to fit in the reader.

To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner.

® Open the CytoFluor software program

® Open the Plate Type drop down menu and examine the list for the available

BD Falcon FluoroBlok Insert Plate format

If the correct plate type is listed, select it and continue. If it is not found, create a new
template as follows:

e Select Plate on the menu bar

e Select Define Plate

e Enter the plate type name in the box (e.g., Falcon FluoroBlok 24-Multiwell or
Falcon FluoroBlok 96-Multiwell)

e Enter the appropriate plate parameters for the insert plate format as shown in
Table 1

e Select Add and OK
Complete Set Up

e Use default settings except as noted below

e Select the Plate Type from the drop down menu

e Select the Excitation and Emission Filter from the drop down menu
e Reads per well 24-well plates: 4

e Reads per well 96-well format: 1

e Center Only

e Gain: 55

Probe Position

The probe must be in the bottom-read position. The probe position is not software
switchable. It must be manually repositioned. Repositioning the probe is a brief operation.
Please refer to the Applied Biosystems CytoFluor manual for specific instructions.

Table 1

BD Falcon™ FluoroBlok™ BD Falcon FluoroBlok BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert

Rows 4 4 8

Columns 6 6 12

X1 315 295 309

X2 2410 2390 2475

Y1 480 470 420

Y2 1740 1730 1797




Bio-Tek
Synergy

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate
Excitation and Emission Filter set installed, and the proper insert plate type is
specified in the Plate Format list.

Check Installed Filter Set
¢ Open the KC4 software program
e Select Wizard
e Select Filter Set
e Select the appropriate Excitation and Emission settings for your fluorophore
e Select Sensitivity
Note: Sensitivity will have to be optimized for your specific application. A setting of

50 is a good starting point. Alternatively, the the plate reader can automatically
adjust the Sensitivity using the Options menu.

Plate Dimensions
To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner.

e Select System

e Select Plate Formats

e Select appropriate plate type (e.g., Falcon FluoroBlok Individual, Falcon FluoroBlok

24-Multiwell, or Falcon FluoroBlok 96-Multiwell) from the pull down menu

If the list does not contain a plate with the correct dimensions, a new plate can be
defined as follows.

e Select New

¢ Enter the template information in the Plate Description dialog box as shown in
Table 2

e Select wells to be read

e Click Next until the end

e Click OK

e Save protocol

e Select New for each new plate

e Select read for each new read on the same plate

Table 2
BD Falcon™ FluoroBlok™ BD Falcon FluoroBlok BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert
Length 127640 127640 127760
Width 85470 85470 85470
Top Left X 14020 12970 14100
Top Left Y 13780 13780 11520
Bottom Right X 110540 109490 113080
Bottom Right Y 71690 71690 74510
Columns 6 6 12
Rows 4 4 8
Well Diameter 6400 6500 3180
Height 23400 24360 19300




BMG

FLUOstar Galaxy and

OPTIMA

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate
Excitation and Emission Filter set installed, and the proper insert plate type is
specified in the Plate Type list.

To accommodate the height of the insert plate, spaces are needed to raise the optics
above the insert plate surface. To obtain spaces, please call 877-BMG-LABS and request
BMG Cat. No. 11-701.

Note: The Galaxy and OPTIMA use different units for entering template data.

Reader Configuration
e Open the FLUOstar software program
e Select the Setup icon on the menu bar to open a drop down menu
e Select Reader Configuration
e Select Fluorescence Intensity and Time Resolved Fluorescence
e Click OK

Note: You will be prompted to check that the right measurement head is installed.
The correct bead can be identified by the presence of two yellow dots on this surface.

Check Installed Filter Set
e Select the Setup icon on the menu bar to open a drop down menu
e Select Filters

¢ Examine the list for the appropriate filters. If the appropriate filters are not listed,
refer to the FLUOstar manual for instructions.

¢ Click OK

Plate Dimensions
To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner.

e Select the Setup icon on the menu bar to open a drop down menu

¢ Select Microplates

¢ Examine the list for a defined plate with the correct dimensions as shown in

Table 3A (Galaxy) or 3B (OPTIMA)
If the list does not contain a plate with the correct dimensions, a new plate can be
defined as follows.
e Select New

¢ A new window will open. Enter the dimensions for the insert plate format as
shown in Table 3A (Galaxy) or 3B (OPTIMA)

¢ Click OK

Bottom-Read Optics

Turn both optics-positioning wheels so that the first position of each is located at
12 o'clock.

Table 3A — Galaxy

BD Falcon™ FluoroBlok™ BD Falcon FluoroBlok BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert

Length 1275 1275 1278

Width 854 854 855

X(1) 140 130 141

Y(1) 138 138 115

X(N) 1105 1095 1131

Y(N) 717 717 745

Format 24 24 96

Table 3B — OPTIMA

BD Falcon™ FluoroBlok™
Cell Culture Insert

BD Falcon FluoroBlok
24-Multiwell Insert

BD Falcon FluoroBlok
96-Multiwell Insert

Length 127.50 127.50 127.80
Width 85.40 85.40 85.50
X(1) 14.00 13.00 14.10
Y(1) 13.80 13.80 11.50
X(N) 110.50 109.50 113.10
Y(N) 71.70 71.70 74.50
Format 24 24 96




PerkinElmer
Victor™

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate
Excitation and Emission Filter set installed, and the proper insert plate type is
specified in the Plate Type list.
Check Installed Filter Set

¢ Open the Victor software program

e Select Tools on the menu bar

e Select Filters from the drop down menu. Note: If Filters is grayed out, then
select User Level..., then click Advanced.

e Select the Emissions Filters tab and examine the list for the appropriate filter
e Select the CW- Lamp (Excitation) Filters tab and examine for the appropriate filter

Note: If the appropriate filter set is not installed, please refer to the Victor manual for
instructions.

Plate Dimensions
To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner.

¢ Open the Victor software program

e Select Tools on the menu bar

e Select Miscellaneous Settings on the drop down menu

¢ Open the Plate Types tab and examine the list for the available BD Falcon

FluoroBlok Insert Plate formats

If the correct plate type is on the list, select it and continue. If it is not found, create
a new template as follows:
e From the Plate Types Screen, select the Add button

e Enter plate type name (e.g., Falcon FluoroBlok 24-Multiwell or Falcon
FluoroBlok 96-Multiwell)

e Click OK

¢ On the Plate Properties screen, enter the appropriate plate parameters for the insert
plate as shown in Table 4

e Click OK
Table 4

BD Falcon™ FluoroBlok™  BD Falcon FluoroBlok BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert

Number of Wells in Row 4 4 8

Number of Wells in Column 6 6 12

Unlidded Plate Height 21 225 19.05

Plate Height with Cover 23.4 24.4 19.3

Strip Orientation Horizontal Horizontal Horizontal

Edge of Plate to Well Center Horizontal  13.75 12.7 14.1

Edge of Plate to Well Center Vertical 13.75 13.75 11.5

Well to Well Horizontal 19.3 19.3 9

Well to Well Vertical 19.3 19.3 9

(continued)




PerkinElmer Entering a Protocol

Victor™ (continued) ¢

Open the Victor software program

Select the Protocol Explorer menu bar icon

Right click the Users Folder

Select New Protocol Group and enter a name for the new folder. Click OK.

Right click the new folder and select New Protocol. Enter the protocol name.
Click OK.

Double click the new protocol

Select the Plate tab and enter the following settings:

— Measurement height: standard

— Plate Type: Select appropriate plate (Individual, 24-Multiwell, 96-Multiwell)
Select the Measurement tab and enter the following settings:

— Measurement Mode: By plate

— Click the Labels icon button

If the correct label parameters are already entered, select it and click OK. If not, enter
the parameters as follows:

Select the Fluorometry tab

Select the Add button

Enter a new label name (e.g., FluoroBlok 24-Multiwell)

Click OK

— On the Fluorometry Label Properties screen enter the following parameters:
e CW-Lamp Energy Scale slider at mid point
e CW-Lamp Filter: select from drop down menu

Emission Filter: select from drop down menu
e Emission Aperture: Normal
e Counter Position: Bottom
e Counter Height: 0.1
e Click OK
Select File on the menu bar and Save the protocol file

To start a protocol, select Start. Note: If a window with the following error
appears: "Wallac 1420 Exception. PLATE ERROR AT MEASUREMENT UNIT.
The plate is lower than described in the protocol”, click Ignore.



PerkinElmer
HTS 7000

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate Excitation
and Emission Filter set installed, and the proper insert plate type is specified in the Plate
Format list.
Check Installed Filter Set

e Open the HTSoft software program

e Select Cancel if the HTSoft Wizard window appears

® Open the Instrument menu tab and select "Parameter Setup..." Select the General
tab and under Detection Method, select Fluorescence mode. Select the Measurement
tab and check and/or set Excitation and Emission Filters; inspect the drop down menus
under Excitation and Emission to examine each list for the appropriate filter set.

Note: If the appropriate filters are not installed, refer to the HTS 7000 manual for
instructions.

Plate Dimensions

DO NOT READ INDIVIDUAL 24-WELL or 24-MULTIWELL FORMATS WITH THE
LID ON THE PLATE.

To properly orient the insert plate in the instrument, the well labeled 'A1"' should be
located at the top left corner.
To see if the plate is already defined:

e Select the Instrument tab

e Select Parameter Setup

e Select the General tab

* Browse the Plate Definition file

If the plate definition file is not found, create a new definition as follows:
¢ Close the Instrument Parameter window
e Under File menu, select HTSoft Wizard
e Select New Plate Definition

® Open the File menu tab and select “Open PlateDef...” and select a plate with similar
number of wells. Close the window. Under the File menu, select "Edit PlateDef..."

e Enter the parameters as shown in Table §
o Select the File menu tab, select "Save PlateDef as...", and enter the new name
e Select Exit

Reading Samples Using Fluorescence-Based Detection
e Open the HTSoft software program
e Under File, select HTSoft Wizard in the drop down menu
o Select Create and Save a New Method.
e Select Next
e Select the Measurement Parameters tab

e Under the General tab, select the Fluorescence Detection Mode and the Plate Definition,
created above

e Under the Measurement tab, select the appropriate Filter settings, and bottom-reading
e Complete the Method and save with a new method name
e Within HTSoft Wizard, select Run an existing method

Table 5
BD Falcon™ FluoroBlok™ BD Falcon FluoroBlok  BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert
Columns 6 6 12
Rows 4 4 8
Well Form Round Round Round
Well Diameter 6.4 6.5 3.18
Upper Left Well X -265 X -1560 X -450
Start Position Y 3000 Y 2812 Y 375
Lower Right Well X 95935 X 94825 X 98895
End Position Y 60750 Y 60937 Y 63000
Unlidded Plate Height 21000 pm 22500 pm 17020 pm
Plate Height with Cover 23400 pm 24500 pm 19300 pm




TECAN
SpectraFluor Plus

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate Excitation
and Emission Filter set installed, and the proper insert plate type is specified in the
Plate Type list.

Check Installed Filter Set
¢ Open the Xfluor4.xls software program (enable macros when requested)
¢ Open the Xfluor4 menu tab to set all operational parameters (Table 6)

e Open the "Edit Measurement Parameter..." tab to check and/or set Excitation and
Emission Filters; inspect the drop down menus under Excitation and Emission, and
examine each list for the appropriate filter set

Note: If the appropriate filters are not installed, refer to the SpectraFluor Plus manual
for instructions.

Plate Dimensions

DO NOT READ INDIVIDUAL 24-WELL or 24-MULTIWELL FORMATS WITH THE
LID ON THE PLATE.

To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner.

® Open the Xfluor4.xls software program (enable macros when requested)
¢ Open the Xfluor4 menu tab. Set all operational parameters (Table 6)

¢ Open the Plate tab (drop down menu) and select “Browse...”to examine the list of
available Plate Definition Files (*.pdf). Select the appropriate BD Falcon™ Insert
System plate type.

If the correct plate type is on the list, select it and continue. If it is not found, create a
new template as follows:

e Exit Plate Definition File list and return to main Excel screen

¢ Open the Xfluor4 menu tab again, then select "Edit PlateDefinition..." tab

¢ Enter the appropriate plate parameters for the insert plate format as shown in

Table 6

¢ Click Update, then click Close (this does not save the file). Under File menu select
“Save PlateDef as...” and save the Plate Definition File (e.g., “Falcon FluoroBlok
24-Multiwell” or “Falcon FluoroBlok Individual™).

Reading Samples Using Fluorescence-Based Detection
¢ Open the Xfluor4.xls software (Enable macros when requested; Connect to reader)
¢ In the Xfluor4 menu list, open the “Edit Measurement Parameter...” menu item;
this opens a tabular listing of available choices
e Under the General tab in the drop down menu, select Fluorescence detection mode
e From the drop down menu, select the appropriate plate definition from the Plate

tab; if desired, check the Multiple reads per well box, then select a pattern (e.g.,
square) and number of replicates (e.g., 2 x 2) from the available options

e Select the appropriate Excitation and Emission filters from the Meas. Params tab
(drop down menu); also select Bottom as Read mode, choose a Gain setting method
(manual, optimal, or from a specific well); and use default integration parameters
(zero time lag, 40 psec integration time)

e Close the “Edit Measurement Parameter...” menu item, then select the Start
Measurement menu item

Table 6
BD Falcon™ FluoroBlok™ BD Falcon FluoroBlok BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert
Columns 6 6 12
Rows 4 4 8
Well Form Round Round Round
Well Diameter 6.4 6.5 3.18
Upper Left Well X -265 X -1560 X -450
Start Position Y 3000 Y 2812 Y 375
Lower Right Well X 95935 X 94825 X 98895
End Position Y 60750 Y 60937 Y 63000
Unlidded Plate Height 21000 ym 22500 pm 17020 pm
Plate Height with Cover 23400 pm 24500 pm 19300 pm




Thermo LabSystems
Fluoroskan Ascent

Set Up

Prior to reading the insert plate, determine that the reader has the appropriate Excitation
and Emission Filter set installed, and the proper insert plate type is specified in the Plate
Format list.

Check Installed Filter Set
¢ Open the Ascent software program
e Select the Setup menu heading
¢ Open the Filters menu heading (drop down list appears)
e Examine the Excitation and Emission Filter combinations, and determine whether
the appropriate filters for the fluorophore to be detected have been installed

Note: If the appropriate filters are not installed, refer to the Thermo LabSystems reader's
manual for instructions.

Plate Dimensions

DO NOT READ INDIVIDUAL 24-WELL or 24-MULTIWELL FORMATS WITH THE
LID ON THE PLATE.

To properly orient the insert plate in the instrument, the well labeled 'A1' should be
located at the top left corner.

e Open the Ascent software program
¢ Select the Setup menu heading
¢ Open the Plate Formats menu heading (drop down list appears)

¢ Under Setup Plate Templates, select the appropriate template for your application (e.g.
"24-well BD Falcon FluoroBlok" to read BD FluoroBlok 24-well Individual Insert
Systems, "24-Multiwell BD Falcon FluoroBlok" to read 24-Multiwell System, etc.)

Note: The standard pre-set parameters for "24 wells Falcon 3047 " is similar to that
for BD FluoroBlok™ Individual Inserts and will work acceptably with the individual
insert plates.

If the correct plate map is on the list, select it and continue. To verify the installed settings
are correct, do the following:

e Select the Modify box, to view parameters

e Check the parameters against the data in Table 7

e If any parameters are incorrect, edit them and save the edited Plate Format definition.
(Template parameter dimensions are in units of 1/10®™ mm [100 microns])

e Click OK several times to save the new Plate Format and return to the main menu
e Verify the correct parameters were entered and saved

If the correct plate map is not listed, you can create a new template as follows:

e Select a similar, but unused plate map. You should select a 24-well template for the
24-Multiwell Insert System, and a 96-well template for the 96-Multiwell Insert System.

e Select the Duplicate box

¢ Rename the template, (e.g., "Falcon FluoroBlok 24-wells" to read FluoroBlok 24-well
Individual Inserts, or "Falcon FluoroBlok 24-Multiwell" to read 24-Multiwell
System, etc.)

e Select the Modify box

* Enter the appropriate plate parameters as shown in Table 7 (Template parameter
dimensions are in units of 1/10® mm [100 microns])

e Click OK several times to save the new Plate Format and return to the main menu

e Verify the correct parameters were entered and saved

Table 7

BD Falcon™ FluoroBlok™ BD Falcon FluoroBlok BD Falcon FluoroBlok
Cell Culture Insert 24-Multiwell Insert 96-Multiwell Insert

Plate Size X 1275 1275 1278

Plate Size Y 854 854 855

Plate Height 210 without lid 225 without lid 193

Well Count X 6 6 12

Well Count Y 4 4 8

Well Diameter X 64 64 31

Well Diameter Y 64 64 31

Well Start X 140 130 141

Well Start Y 138 138 115

Corner Well Distance X 965 965 990

Corner Well Distance Y 579 579 630

Well Type Circle Circle Circle

Can be read with Lid No No No

Note: Gain settings are automatically set by the plate reader.
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